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Preparation your data for importing into u3a Beacon                    
 

1 Introduction 
Having applied to use Beacon the next phase includes moving your data onto Beacon – data 
preparation and migration. You will have been allocated a Migration expert to assist with this 
phase, although in some cases your Supporter will also be in the Migration Team. Your Migrator will 
be creating and setting up your Beacon live site.  
 
In order to do this your data will need to populate an Excel template. After studying this guide 
discuss and agree with your Supporter and Migrator an approach. This could vary between giving us 
“what you have as it is” to populating the template with your data. Note also that, depending on 
their experience, you Supporter will be working with your Migrator in data preparation. 
 
First some important best practice. If you email your data to the Beacon Team (or anyone else) and 
it includes personal information – names, addresses, phone numbers – then password protect the 
file and email the password separately. The Appendix has more on doing this with Excel. 
 

a) Check that your data is Up to Date, Accurate & Complete 
Whatever information you collect about your members, groups, finances, etc. make sure that you 
have as few ‘gaps’ as possible.  This may not matter as far as migration is concerned but ‘going live’ 
with Beacon is a good time to consolidate. 
Using the guidance in section 2 below, check that there are no obvious spelling mistakes or errors in 
phone numbers, post codes, email addresses, etc. Also that ‘spacing’ is consistent and that data of 
the same type ‘looks the same’ (e.g. dates). If more than one member lives at the same address, 
ensure the address is identical for both. 

Do it yourself or have the Beacon Team do it for you? 
Study the steps below. If you feel you have the skills (and the inclination) to populate the Migration 
spreadsheet template yourself, or give it a go, then by all means proceed. 
Alternatively, the conversion can be done for you. Just send what you have (password protected 
– see above). Some errors are invariably found and if ‘local knowledge’ is needed to correct them 
you will be contacted. When declared error-free, your data will be transferred to the Beacon system 
and you will have a Live Site! 

b) Copy your data into the Excel Template 
Copy your data into the template file that accompanies this guide. Populating the template doesn’t 
require any particularly advanced spreadsheet skills, other than a systematic approach and an 
attention to detail. 

c) Add missing information 
Add any missing information to the template using the guidance in the worksheet sections below. 
Not all columns in the Excel file need to be completed – those that are required have a tick in the 
‘Req.’ column and are highlighted yellow in the Template. 

d) 1st stage checking 
When you think that your data is complete, do a thorough check to make sure that all the required 
information has been supplied and is in the correct format. There are some tips in the Appendix to 
help you with this. It is a good idea to involve one or two other people in this stage of checking. 

e) 2nd stage checking 
When you have completed your own checks, forward a password protected copy of the file to your 
Migrator (and Supporter if they are helping) for additional checking (see the Appendix for how to do 
this). It is likely that some errors will be found and if ‘local knowledge’ is needed to correct them you 
will be contacted for clarification. 
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f) Migration 
After the data has been checked and any corrections made you give the go-ahead to your Migrator. 
After migration you will be sent the Beacon Live Site ‘What To Do Now’ document which describes 
how to complete your Beacon set-up. Your Supporter will be notified that your site is live. 
Be aware that charging for Beacon currently starts the on the 1st of the month following the month 
you go live. If this is issue for you, and it is towards the end of the month, consult with your Migrator 
about delaying. 
 
 
2 General notes about data conversion 

• Make a copy of the original template file and during your work in case you need to start again 
or go back a step.  Save the workbook that you are going to be using and include your u3a 
name as part of the filename. 

• Before copying any data into the template, first complete the u3a_Details worksheet, see 
below 

• Text columns have a maximum width. This is indicated below by e.g. TEXT25 meaning a 
maximum of 25 characters for an entry. 

• Please familiarise yourself with the content of both this document and the template before 
you attempt to move your data. Copy & paste your data into the template column by 
column, worksheet by worksheet. 

• All date entries must be ‘text’ strings in the form “dd/mm/yyyy” (this can be done for you) 
• Telephone and mobile numbers must also be text (not numbers or leading zeros are lost). 
• Capitalisation will not be altered during import so ensure that names, addresses etc. are 

already keyed in with the correct capitalisation.  
• When uploading Groups data you can optionally specify a leader/convenor membership 

number. Populating groups with members and additional leader/convenors needs to be done 
on Beacon after you go live. 

 
 
3 The Beacon data preparation template 
The Excel workbook consists of five worksheets as described below: 
Note: similar information can be viewed in the ‘cell comments’ in the template by hovering your 
cursor over the red triangles at the top right corner of some cells. 
 
 

Sheet 
Name 

Contents Status 

u3a_Details Site parameters and settings Required 

members Names, addresses, and contact details etc. of members.  Required 

venues Details of all the venues you use for group meetings, including 
address, telephone numbers, contacts, email, accessibility. 

Optional 

groups Name, number of leaders, venue identifier, meeting dates and 
times 

Optional  

finance Transaction details: date, time, amount, related members/groups Optional  
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3.1 u3a_Details Worksheet (required) 

Column A Comments 
u3a name How your u3a name will be displayed in Beacon (do not 

include u3a) and do not include a comma. Use of & is OK. 
members Enter “Y” or “N” to show whether you intend to load data. 
venues 
groups 
finance 
Financial year starts in First month of the Finance Year. MM format, e.g. 03 for March 
Membership year starts 
in 

First month of the Membership Year. MM format, e.g. 05 for 
May 

Beacon administrator 
name 

Site Administrator’s name 

Beacon administrator 
email 

Site Administrator’s email address 

Membership classes in 
use 

Individual, Joint and Associate are present. You can add 
others  

Status values in use Current, Lapsed, Resigned and Deceased are present. You 
can add others.  

Alias for group (if used) An alternative description for your groups, e.g. classes. 
Alias for leader (if used) An alternative description for your group leaders, e.g. 

convenors. 
Groups 
Faculties (if used) List any Faculties referred to in the groups worksheet. 
Finance uploads 
Finance/bank account 
internal names 

Current always exists and by default is the account 
membership fees are paid into. List any additional bank 
account names in the following rows. If one of these is called 
Membership that will be setup to receive membership fees. 
See the Beacon Considerations document for more details. 
We are NOT looking for sort codes or account numbers. 

Names of financial 
categories 

List the names of any financial categories referred to in the 
finance worksheet. 

Custom fields and Polls 
custom fields (if in use) Poll fields (on which you can select to filter members in 

Beacon) are preferred to custom fields. Only load these if data 
is present. To avoid the use of custom fields, consider 
combining a poll with information in the notes field. 

Poll fields (if in use) 

General 
Next mem_no No need to make an entry here unless you need to leave a gap 

between the highest member number uploaded from your 
data and the first new member created on Beacon. 

 
 
3.2 Members worksheet (required)  

 
[A] indicates further explanation below the table. 
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Col Req. 
Column 
header 

Type & 
max 

length 
Comment 

A  mem_no Integer Member number. Must be unique 

B  pmem_no Integer Optional partner’s member number. Needs 
identical address as member. Must exist and be 
unique. The status of both members must be 
‘Current’. [A] 

C  title Text5 Must be present if gift_aid date present 
otherwise optional. Mr, Mrs, Miss, Ms, Dr, etc. 
Only use letters and no full stops or spaces. 

D ✓ forename Text25 Can contain more than one name e.g. Mary Jane. 
Apostrophes, hyphens and ö, é, è, à are 
supported. [B] 

E ✓ surname Text25 As forename. 

F  initials Text5 Upper case, A to Z only. No full stops or spaces. 
If left blank, the first letter of the Forename will 
be used. 

G  suffix Text5 e.g. MBE, MP. Upper case, A to Z only. No full 
stops or spaces. 

H  familiar_name Text15 Optional. May be used when a member prefers 
to be known by a different name, e.g. Bill rather 
than William. 

I ✓ memclass Text25 Individual, Joint and Associate are provided. 
Others can be used if entered on the 
u3a_Details worksheet. 
Joint members must be paired using Col B 
pmem_no above. 

J ✓ status Text25 Current, Lapsed, Deceased & Resigned are 
provided. Others can be used if entered on the 
u3a_Details worksheet. 

K ✓ house Text25 House number or name. Must not be blank [C] 

L  address1 Text30 Can be blank (but usually won’t be) 

M  address2 Text30 Can be blank 

N  address3 Text30 Can be blank 

O ✓ town Text25 Must not be blank 

P  county Text25 Optional so can be blank 

Q ✓ postcode Text10  Must not be blank. (special format) 

R  telephone Text15 Can be blank [D] 

S  mobile Text15 Can be blank [E] 

T  email Text47  Can be blank (special format – needs an @) 

U  giftaid_date Text10 Optional or dd/mm/yyyy [F] 
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Col Req. 
Column 
header 

Type & 
max 

length 
Comment 

V  emergency Text255 Emergency contact, e.g. a name and phone 
number 

W  affiliation Text25 Name of the u3a an Associate member is fully 
paid up to [G] 

X  notes Text Optional. If used beware of sensitive information 
and your Data Protection policy. 

Y ✓ joined Text10 dd/mm/yyyy [H] 

Z ✓ renew Text10 dd/mm/yyyy [I] 

AA-
AD 

 custom fields 
1-4 

Text50 Must be named e.g. custom1-transport and 
listed in the u3a_Details worksheet [J] 
Must be in lower case. 

AE-
AH 

 Poll fields 1-4 Text1 Must be named e.g. poll1-Committee and listed 
in the u3a_Details worksheet (may be mixed 
case, max length 25 characters) 
May only contain “1” or be blank. 

 
[A] Partner’s Number must be filled for pairing members with a “Joint” membership class. It can 
also be used for members who share the same address with another member – not necessarily a 
spouse or partner or having “Joint” membership. The result is to combine two members in the 
TAM list and on address labels so that they share post office mail. 
Only 2 members at the same address can be set as sharing an address with each other, although 
4 members can be associated in two pairs. 
[B] Forename: This field will be used when emails are personalised with a member’s forename, so 
you may prefer to not to store middle names in this field. Middle initials can be recorded in the 
Initials field, e.g. for Michael John, put Michael in column D and MJ in column F. 
[C] Addresses: ‘house’ is merged with ‘address1’ on the Address labels download when ‘house’ is 
no more than 7 characters long. If greater than 7 characters they are shown on separate lines so 
that the text is not too wide for the label. 
You may sometimes wish to add commas in the ‘house’ field to break up the text as shown in the 
examples below. ‘House’ can have at most 25 characters and there are circumstances where this 
is not enough and words have to be abbreviated or other compromises made. 
‘House' and ‘postcode’ (only) are used in Gift Aid reports for HMRC and need to identify the 
dwelling. Current HMRC guidance states: “As a minimum HMRC will accept the number (or name 
as appropriate) of their home and their full Postcode”. 
It pays to be consistent with the way that columns L to O are filled in. This makes searching and 
filtering easier in Excel ‘addresses exports’, e.g. when searching for everyone that lives in a 
specific street or district. 
The official address can be checked at https://www.royalmail.com/find-a-postcode which will list 
all the 'house' entries for a postcode. This will help with deciding whether, for example, just “Flat 
3” is acceptable or “Flat 3, 10” is preferable (see table below). 
Typical examples of suggested house/address combinations are: 
 

house address1 address2 address3 town 
25 Main Road Carlton   Nottingham 
221 5th Avenue Gedling   Nottingham 

https://www.royalmail.com/find-a-postcode
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Manor Farm  Lambley   Nottingham 
The Old Rectory Church Lane Colwick  Nottingham 
Beacon House, 30 Station Road Carlton   Nottingham 
Flat 3, 10 Mount Pleasant Gedling   Nottingham 
Flat 1, Albany House, 
23 

Main Road Carlton   Nottingham 
 
Refer to the Beacon User Guide, section 4.3.1, for examples of the address labels download, TAM 
List & Gift Aid submissions generated from these addresses. 
 [D] Telephone: It is recommended that home phone numbers are in a consistent format. This 
makes them easier to read and to spot any incorrect numbers that contain the wrong number of 
digits. The recommended format varies depending on the number of digits in the area code, e.g. 
02x xxxx xxxx      For Cardiff, Coventry, London, Portsmouth, 
Southampton, Northern Ireland 
01xx xxx xxxx   For most other major cities 
01xxx xxxxx(x) For smaller cities, provincial towns and rural areas 
01xxxx xxxx(x)  For rural North West England and Borders 

[E] Mobile: There is no recognised standard format for mobile numbers. ‘07xx xxx xxxx’ is 
probably as good as any, or you may wish to use the same format as your home phone numbers. 
[F] Gift Aid date: Only applies if your u3a is registered with HMRC to claim Gift Aid. As well as 
being the date consent was granted, the Gift Aid date is a flag to say the member has consented 
and cannot be earlier than the member’s joining date. Beacon makes claiming Gift Aid easy, but 
you will need to make a Gift Aid claim from HMRC for the period up to your going live date using 
your current process. You can only avoid this by migrating Financial Transactions that include 
Gift Aid qualifying amounts for member fees and donations (Finance column J) but in general this 
will not be worth the effort. 
Note that HMRC do not require Gift Aid declarations to cover a financial year, it can be any 
period. 
For members who have given Gift Aid consent enter the date it applies from. 
HMRC require a Title (Mr, Ms etc.) to be included in a claim so complete this as well. 
[G] Affiliate: If the Membership class of a member has ‘Full member of another u3a’ ticked 
(Associate class) then this attribute is now required on Beacon. We strongly recommend 
entering the name of the u3a the member is a full member of on the template, even though the 
data upload process does not enforce this.  
[H] Joined: If the joining date is not known, consider using the first day of the current 
membership year for current members and the first day of the previous membership year for all 
others. 
[I] Renew: For current members this is the first day of the next membership year. For non-
current members this is the first day of the membership year in which they should have renewed.  
[J] Custom and Polls: Note that custom fields are not used by most u3as due to limitations – 
discuss your requirement with your Migrator first. If you are using either custom fields or Polls, 
you must add the names you wish these fields to have after the hyphens in the column headers 
of the relevant columns (AB to AI in the members sheet). Custom field name must be lower case. 
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3.3 venues worksheet (optional)  

 

Col Req. 
Column 
header 

Type & 
max 

length 
Comment 

A ✓ name Text50 Each Venue Name must be unique. May 
include letters, numbers, spaces and some 
special characters, e.g. “ – “ (not “ & “). 

B  address Text50 Not including postcode 

C  postcode Text10 All letters in upper case 

D  telephone Text15 [D] (above) 

E  contact Text50 Name and/or role of a contact person at the 
venue 

F  email Text47  

G  website Text50 Note the length limit. You will be able to 
manually add the URL after your site goes 
Live. Must start HTTP:// or HTTPS:// 

H  notes Text  

I  is_private Text1 Enter “1” if it is a private address, e.g. a 
member’s house. This will enable the address 
details to be hidden in certain places in 
Beacon 

J  is_accessible Text1 Enter “1” if it is an accessible venue. 

 
 
 
3.4 groups worksheet (optional)  
 

Col Req. Column 
header 

Type & 
max 

length 
Comment 

A ✓ name Text30 Each Group Name must be unique. May 
include letters, numbers, spaces, full stops, 
minus “-“ and quotes. 
Due to a bug useful characters such as braces 
() and ampersands & cannot be used (see 
below) 

B  faculty Text30 If present, must exactly match the name of a 
faculty, as defined on the u3a_Details 
worksheet. 

C  status Integer 1=Inactive, 2=Active, defaults to Active.  

D  leader Integer if present, must be the mem_no of a member 

E  venue_name Text50 must exactly match the name of a venue 
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Col Req. 
Column 
header 

Type & 
max 

length 
Comment 

F  info Text General information about the group which 
may be visible to the general public.  

G  meets_when Text50 e.g. 2nd Tuesday at 10:00am, about once a 
month, regular visits to local theatres, etc. 

H  start_time Text5 Regular start time if applicable in the form 
HH:MM.  

I  end_time Text5 Regular end time in the form HH:MM. See note 
[J]. 

J  max_members Integer Use if there is a limit on the size of a group. 

K  notes Text250 Use for adding information that you do not 
wish to be seen by the general public. 

L  contact Text30 e.g. John on 0123 456 7890. Can be seen by 
the public, so don’t use personal email 
addresses. 

M  join_online Text1 Enter “1” to allow members to join the group 
online 

N  waiting_list Text1 Enter “1” to enable a waiting list 

O  notify Text1 Enter “1” for leaders to be informed by email 
when members join the group or waiting list 
online. 

 

[A] Group name: One your data has been loaded onto Beacon your Group names can be edited 
through the Beacon screens to include characters such as ( ) & and many more. 
[J] End time: When viewing a pdf copy of the Calendar, the date and start time are shown 
together in one column and the end time is shown in a separate column. This has sometimes 
caused confusion with members reading the end time as the start time and turning up late for 
meetings. So consider carefully whether you really need to specify the end time. 

 
3.5 finance worksheet (optional)  

 
Note: very few u3as upload Finance information at migration. One reason is the import process 
has limitations such as not supporting transfers. Most that use the Finance capabilities of 
Beacon do so at the start of a subsequent financial year. 

 
 

Col Req. Col. header 
Type & 

max 
length 

Comment 

A ✓ t_date 
Text10 dd/mm/yyyy transaction date. Must not 

be in the future 

B ✓ account Text15 Must match the name of an account as 
defined in the u3a_Details worksheet. 
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Col Req. Col. header 
Type & 

max 
length 

Comment 

C ✓ amount Decimal No symbol, use negative values for debits 

D ✓ payment_type Integer 1 = cheque, 2 = cash, 3 = PayPal, 4 = 
standing order, 5 = direct debit, 6 = BACS 
(or inter-bank transfer),  7 = credit card 
(for payments). 

E ✓ category Text25 As a shortcut 1 = membership, 2 = donation 
Other categories must be defined in the 
u3a_Details worksheet and their name 
entered as full text. 

F ✓ payee Text30 The payee or the payer. 

G  cheque Text10 The cheque number, if applicable. 

H  
details 

Text50 Additional information about the 
transaction. 

I  
mem_no 

Integer Member’s Number if the transaction is 
associated with a member who exists in 
the members worksheet. 

J  
giftaid 

Decimal Amount of this transaction that qualifies 
for Gift Aid. Mem_no must be present. [F] 
(above) 

K  

claimed 

Text10 dd/mm/yyyy The date when Gift Aid 
claimed. Must not be in the future. Leave 
blank if Gift Aid has not been claimed on 
the transaction. 
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Appendix – Tips for preparing and checking your data 
 

Password Protection 
When emailing files that contain members’ personal data, the Workbook (not the individual worksheet) 
must first be password protected. This varies with the software you are using and versions of Excel. 

1. Select File > Protect Workbook > Encrypt with password OR for recent version of Excel File > Save 
As > Tools (on the bottom right) > General Options… 

2. Type in a password 
3. Type in the password a second time to confirm and click OK. 

Send the password-protected file and notification of the password in a separate email. 
Note: you may wish to keep a copy of the file without password protection just in case you forget the 
password and can’t open the file! 

Splitting addresses 
The Migration Team have tool they can use to do this for you with minimal work. 
To have a go yourself this is a suggested approach. 
If a members house number and street is currently contained in the same cell in Excel, here is one 
method that you can use to split the data up into ‘house’ and ‘address1’ as required in the template file: 

1. Copy your data into a blank worksheet. It is assumed the house/street information will be in 
column A, but the method will work equally well with it in other columns. 

2. Insert (say) 3 blank columns to the right of column A. 
3. Highlight column A and do a ‘Find & Replace’ (Ctrl + H) to replace all the blank spaces with 

commas. 
4. Select ‘Data > Text to columns’. At the first step of the resulting wizard make sure that ‘Delimited’ 

is selected. At the 2nd step tick ‘comma’ only and click ‘Finish’ to separate component parts of 
the addresses into separate columns. 

Addresses such as “22 Station Road” will have been separated into 3 columns. You can stitch ‘Station’ and 
‘ Road’ back together as follows: 

1. In cell D1 enter the formula: =CONCATENATE(B1," ",C1) 
2. Copy cell D1 downwards to the bottom of the list 
3. Highlight column D and copy it (Ctrl +C) 
4. Right click anywhere in Column D and select ‘Paste Special’ from the sub-menu. 
5. On the next screen select ‘values’, followed by OK. 
6. Delete columns B & C. 

Checking data in the members’ worksheet 

Column Filters 
Put a filter on the whole table by highlighting the first row and selecting Data > Filter. You can do the 
following checks by clicking the arrows in the column headings. Any blank rows can be found by unticking 
‘select all’ and ticking ‘(blanks)’ at the bottom of the list. Any other unusual entries should be easy to spot 
at the top or bottom of the filter. 
These checks can be done on any column, but particularly: 

• mem_num (A) 
• Memclass (J) 
• Status (K) 
• Town (P) 
• Post Code columns 
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Version Date By Changes 
v6 July 2018 Graeme 

Bunting 
u3a_Details worksheet 
Extended guidance 

v7 July 2019 Graham Tigg Guidance wording changed to reflect new 
Beacon Team processes 
Include more info on Gift Aid implications 

v8 July 2019 Graeme 
Bunting 
Graham Tigg 

Improved house/address guidance and Gift Aid 
wording. 

v9 July 2019  Combined v7 and v8 
v10 Oct 2019 Graham Tigg Changed Finance account suggestions (set up 

a Membership account) 
Changed name from BDM 

v11 Nov 2019 Graham Tigg Clarified custom fields must be in lower case 
v12 Jan 2020 Graham Tigg Emphasised that Joint members need to be 

paired 
v13 Jun 2021 Graham Tigg More detail on characters acceptable in Group 

names 
Added words on approach and potential role of 
the Supporter. 
u3a name not to use comma (makes sending 
system emails potentially unreliable) 

v14 Nov 2022 Graham Tigg Stated poll name can be up to 25 characters 
v15 Sep 2023 Graham Tigg Affiliation to be completed if membership class 

is ‘Associate’ 
v16 Sep 2023 Graham Tigg Title to be completed if Gift Aid date present 
V17 Dec 2023 Graham Tigg Clarified Financial categories 
V19 Jun 2024 Graham Tigg Removed ‘sex’ field 

  


